User Guide

Population Lifecourse Exposure to Health Effects Model (PLETHEM)

PLETHEM CRAN Release v1.1.0
Revised Sept 30th, 2020
# Table of Contents

1. **List of resources** .......................................................................................................................... 6
   1.1. Supporting files ............................................................................................................................ 6

2. **Introduction** ................................................................................................................................. 7

3. **Scope and goal** ............................................................................................................................. 8

4. **Introduction to Physiologically Based Pharmacokinetic (PBPK) Modeling** ................................. 9
   1.2. What is PBPK modeling? ................................................................................................................ 9
   1.3. What is PBPK modeling used for? ................................................................................................. 9
       1.3.1. Route to Route Extrapolation ................................................................................................. 9
       1.3.2. Inter-Species Extrapolation .................................................................................................. 9
       1.3.3. Intra-Species Extrapolation .................................................................................................. 10
       1.3.4. High-to-Low Dose Extrapolation ........................................................................................... 10
       1.3.5. Estimation of Response From Varying Exposure Conditions and Across Life-Stages .......... 10
   1.4. Where to go for more information on PBPK Modeling .................................................................... 10

5. **Installing prerequisites and getting started** .................................................................................. 12
   1.5. Installing R ................................................................................................................................... 12
       1.5.1. Installing on Windows ............................................................................................................ 12
       1.5.2. Installing on Mac OS X ......................................................................................................... 12
   1.6. Installing Rstudio Desktop ............................................................................................................ 12
   1.7. Installing PLETHEM and launching the interface ........................................................................... 12

6. **Modeling using the rapidPBPK model** .......................................................................................... 14
   1.8. Loading and running an existing project ....................................................................................... 14
       1.8.1. Loading an existing forward dosimetry project ...................................................................... 14
       1.8.2. Running a forward dosimetry simulation and looking at the results ...................................... 14
       1.8.3. Running a Monte Carlo simulation and looking at results ..................................................... 15
       1.8.4. Exiting the modeling user interface ......................................................................................... 15
   1.9. Creating a project for a new model ................................................................................................. 16
   1.10. Creating datasets for the simulation ............................................................................................. 16
       1.10.1. Creating an exposure dataset ............................................................................................... 16
       1.10.2. Creating a chemical dataset ................................................................................................ 17
       1.10.3. Creating physiological dataset ............................................................................................ 19
       1.10.4. Creating an ADME set ......................................................................................................... 19
       1.10.5. Creating a parameter variability dataset ............................................................................... 23
   1.11. Combining all the sets to make a simulation ............................................................................... 23
       1.11.1. Simulation Set- Creating a simple forward dosimetry simulation ........................................ 23
       1.11.2. Simulation Set – Creating a simulation for performing forward dosimetry with Monte Carlo analysis .............................................................................................................. 24
       1.11.3. Simulation Set – Creating a simulation for performing reverse dosimetry .......................... 25
       1.11.4. Simulation Set – Creating a simulation for performing route-to-route extrapolation ............ 27
   1.12. Running simulations and plotting results with the rapidPBPK model ......................................... 29
       1.12.1. Run a simple Forward Dosimetry Simulation ....................................................................... 29
       1.12.2. Concentration Plots – Plotting concentration plots ............................................................... 29
1.12.3. Adding external PK data to project ................................................................. 30
1.12.4. Plotting PK data against simulation results .................................................... 31
1.12.5. Plotting exposure ............................................................................................ 31
1.12.6. Plotting amounts ............................................................................................ 31
1.12.7. Mass Balance ................................................................................................. 31
1.12.8. Parameters .................................................................................................... 32
1.12.9. Running Monte Carlo analysis ....................................................................... 32
1.12.10. Running reverse dosimetry analysis .............................................................. 33
1.12.11. Running route-to-route extrapolation ............................................................ 34

1.13. Importing exposure estimates into PLETLEM .................................................... 34
1.13.1. Importing SHEDS-HT ...................................................................................... 34
1.13.2. Importing TRA exposure estimates ................................................................. 36
1.13.3. Importing SEEM estimates into PLETLEM ...................................................... 37
1.13.4. Importing ConsExpo exposure estimates into PLETLEM ............................... 38
1.13.5. Importing Exposures using the batch import file ............................................. 38

7 Performing high-throughput IVIVE using PLETLEM ............................................... 40
1.14. Starting HT-IVIVE user interface and loading chemicals ................................. 40
1.14.1. Launching the HT-IVIVE user interface ......................................................... 40
1.14.2. Importing chemicals to the project ............................................................... 40
1.15. Parameterizing the HT-IVIVE model ................................................................. 40
1.15.1. Entering Physiological and Chemical Parameters ........................................... 40
1.15.2. Enter the in vitro point of departure ............................................................... 42
1.15.3. Select the HT-IVIVE Type .............................................................................. 42
1.15.4. Parameterizing Clearance Models ................................................................. 42
1.16. Running the HT-IVIVE Model and saving results .............................................. 44
1.16.1. Running the HT-IVIVE model ....................................................................... 44

8 Kinetically Derived Maximum Tolerated Dose Workflow ....................................... 46
1.17. Template for the KMD workflow in PLETLEM ............................................... 46
1.18. Accessing the web application .......................................................................... 46
1.19. KMD workflow in PLETLEM ........................................................................... 47
1.19.1. Upload the filled template .............................................................................. 47
1.19.2. Interpreting the results .................................................................................. 48

9 Using Forward Dosimetry in Ecotoxicology ............................................................. 49
1.20. Creating a new project ....................................................................................... 49
1.21. Create an exposure set ...................................................................................... 49
1.22. Create a chemical set ....................................................................................... 49
1.23. Create a physiological set .................................................................................. 49
1.24. Define variability ............................................................................................... 50
1.25. Create a simulation ........................................................................................... 50
1.26. Running the simulation ..................................................................................... 51
1.27. Viewing and exporting simulation results ........................................................ 51
1 List of resources

ScitoVation maintains a collection of PLETHEM resources at https://www.scitovation.com/plethem/.

1.1 Supporting files

This guide includes an appendix with examples for each of the workflows called PLETHEM Workflow Tutorial Series:

- Annex 1: Using forward dosimetry to generate biomonitoring equivalents
- Annex 2: PBPK Modeling and Reverse Dosimetry Workflow
- Annex 3: PBPK Model and Route-to-Route Extrapolation Workflow
- Annex 4: Using HT-IVIVE to estimate equivalent applied dose and margin of exposure from in vitro data
- Annex 5: Kinetically Derived Maximum Tolerated Dose (KMD) Workflow
- Annex 6: Using forward dosimetry in ecotoxicology

This guide includes reference to number of samples files. These are available for download at https://www.scitovation.com/plethem/.

<table>
<thead>
<tr>
<th>File name</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>plethem_in_vivo_time_course.csv</td>
<td>Example of formatted file to import in vivo data</td>
</tr>
<tr>
<td>plethem_biomonitoring_data.csv</td>
<td>Example of formatted file to import biomonitoring data</td>
</tr>
<tr>
<td>plethem_tra_exposure_estimates.xls</td>
<td>Populated ECETOC TRA exposure estimation sheet</td>
</tr>
<tr>
<td>plethem_seem.sqlite</td>
<td>Data for SEEM exposure estimates</td>
</tr>
<tr>
<td>plethem_exposure_template.xlsx</td>
<td>Excel file for importing exposures into PLETHEM. This file can be edited if the sheet names and column names in each sheet are kept the same</td>
</tr>
<tr>
<td>plethem_kmd_data.csv</td>
<td>Data for KMD analysis</td>
</tr>
<tr>
<td>plethem_demo_project.Rdata</td>
<td>Example of project that can be loaded and run</td>
</tr>
</tbody>
</table>

The files needed to run the workflows can also be obtained by emailing plethem@scitovation.com.
2 Introduction

Population Lifecourse Exposure to Health Effects Model (PLETHEM) is an open-source package for physiologically based pharmacokinetic (PBPK) modeling written in R statistical language. The main aim of the package is to ease PBPK modeling for most applications by providing powerful modeling workflows wrapped in an easy-to-use and intuitive user interface. PLETHEM supports PBPK modeling, in vitro to in vivo extrapolation (IVIVE), and high-throughput IVIVE. PLETHEM consists of a master database of physiological parameters, lifecourse equations, QSAR models, and chemical information. Additional physiological parameter sets, or chemicals can also be stored externally as a user database. Finally, PBPK modeling workflows in PLETHEM save all the modeling data in a project file that is platform agnostic and can be opened through any other PLETHEM installation.

R can be accessed from the command line or via several interactive development environments (IDEs). We recommend using RStudio¹ as the IDE when you are working in PLETHEM. Guidelines for installing Rstudio are included below. To test the capabilities of the package, we will be running a demo project that is already created and saved. We will also create a new project for simulating a dummy chemical dataset using PBPK models. Finally, we will run an HT-IVIVE workflow and a KMD workflow.

¹ https://www.rstudio.com/
3 Scope and goal

The goal is to guide the users through the workflows within PLETHEM package by running through a few sample scenarios. We will provide detailed stepwise instruction and all the corresponding data files needed to run the following workflows. Only users who are comfortable programming in R should use this version of PLETHEM. We regularly update the CRAN repository with updates to the package. If you are new to R or have never done programming please install and use the stable public release of the package from the CRAN archive.

This document will describe:

1. Installation of R and RStudio.
2. Installation of the public release of PLETHEM from CRAN.
3. Loading and running an existing PLETHEM project for PBPK modeling.
4. Creating, running, and saving a new PLETHEM project for PBPK modeling.
5. Importing exposure estimates for PBPK modeling.
6. Running HT-IVIVE for estimating equivalent dose from in vitro point of departure.
7. Running the Kinetically Derived Maximum Tolerated Dose (KMD) workflow.
8. Running a new ecotoxicological project.

Problems, typos, or areas for improvement encountered can be sent to plethem@scitovation.com with “PLETHEM Bug Report” as the subject of the email.
4 Introduction to Physiologically Based Pharmacokinetic (PBPK) Modeling

4.1 What is PBPK modeling?

Physiologically based pharmacokinetic (PBPK) modeling is a mathematical tool for describing how a chemical distributes throughout a biological system—such as the human body—following an exposure. PBPK modeling integrates a physiological model of the body and compound-specific data to predict the pharmacokinetics (PK) of drugs and chemicals in plasma and tissues. The body, its constitutive organ systems, and the transit of a compound of interest are represented using a mathematical series of equations. The model equations are evaluated following a simulated exposure to estimate how a compound distributes across various organs over time, and how it is eventually eliminated from the body.

Each species is modeled as a structure composed of physiologically relevant compartments, where each compartment often represents a single organ or tissue interconnected by blood flow.

4.2 What is PBPK modeling used for?

4.2.1 Route to Route Extrapolation

- This is used to estimate a dose through routes of exposure for a reference dose that was established through a different route of exposure.
- Common use case: you have a known lowest-observed-adverse-effect level (LOAEL) for an inhalation exposure for a compound and would like to estimate an equivalent LOAEL for an oral exposure.

4.2.2 Inter-Species Extrapolation

- Since mammalian species share many common physiological characteristics it is expected that they may respond in a somewhat similar manner to toxic substances. While many differences
exist between species, allometric relationships among physiological parameters can be used for quantitative interspecies extrapolation.

- Common use case: you have a dose of exposure giving a certain concentration in blood in rats and would like to estimate the dose of exposure giving the same blood concentration in human.

### 4.2.3 Intra-Species Extrapolation

- This captures the human variability by including in the PBPK model the life-stage of concern.

### 4.2.4 High-to-Low Dose Extrapolation

- PBPK models facilitate high-dose to low-dose extrapolation of tissue dosimetry by accounting for the dose-dependency of relevant processes (e.g., saturable metabolism, enzyme induction, enzyme inactivation, protein binding).
- During the conduct of high-dose to low-dose extrapolation, no change in the parameters of PBPK model is required except for the administered dose or exposure concentration.

### 4.2.5 Estimation of Response From Varying Exposure Conditions and Across Life-Stages

- PBPK models can also be used to interpret biomonitoring data by estimating potential exposure doses (reverse dosimetry).
- Coupled with pharmacodynamics (PD) models, these PBPK models can predict both dose-response and time-course for the development of adverse effects.

### 4.3 Where to go for more information on PBPK Modeling


5 Installing prerequisites and getting started

5.1 Installing R

PLETHEM requires R version 3.4.0 (released April 2017) or newer.

5.1.1 Installing on Windows

a. In a web-browser, navigate to https://cran.r-project.org/
b. Select “Download R for Windows” under “Download and Install R.”
c. Select “base.”
d. Select “Download R 4.(version) for Windows.”
e. Save and run the installer file.

5.1.2 Installing on Mac OS X

a. In a web-browser, navigate to https://cran.r-project.org/
b. Select “Download R for (Mac) OS X” under “Download and Install R”
c. Select the "Latest release".
d. Click the link (e.g., "R-4.0.2.pkg") to download and run the installer file.

5.2 Installing Rstudio Desktop

a. In a web browser, navigate to: https://www.rstudio.com/products/rstudio/download/#download

b. Select from "Installers for Supported Platforms" an option that matches your operating system:
   i. For Windows: "RStudio 1.(ver) - Windows Vista/7/8/10"
   ii. For Mac OS X: "RStudio 1.(ver) - Mac OS X 10.6+ (64-bit)"

c. Save and Run the executable file.

5.3 Installing PLETHEM and launching the interface

PLETHEM is started from RStudio and launches in the user’s default browser application.

a. Open the recently installed RStudio (Section 5.2).
b. Install PLETHEM by typing install.packages(‘plethem’) in the R console.
c. Load the PLETHEM package by typing library(plethem) in the R console.
d. Launch the PBPK modeling workflow by typing interactivePBPK() in the R console. This launches the forward dosimetry, reverse dosimetry, and route-to-route extrapolation user interface in the default browser. For the HT-JVIVE user interface, type interactiveHT() in the R console and for the ecotoxicological user interface, type interactivePBPK(“fishPBPK”) in the R console.

---

2 Depending on your system and institutional policy, installation may require assistance from your information technologies department.
3 At the time of preparing this document, the latest release was R-4.0.2.
4 At the time of preparing this document, the current version of RStudio Desktop was 1.3.1073.
c. For the KMD user interface, open a web browser (preferably Google Chrome) and navigate to https://scitovation.shinyapps.io/plethem-MTD/. This will open the PLETHEM KMD web application.
6 Modeling using the rapidPBPK model

6.1 Loading and running an existing project

6.1.1 Loading an existing forward dosimetry project

a. Go to File and click on the “Load” tab. This will open a dialog box called “Load New Project”.

b. Click “Confirm”. This opens a new window (note: this window may open behind you current RStudio window) called “Select PLETHEM Project”. Click on “File select” and navigate to the location where you have stored the materials for this and select “plethem_demo_project.Rdata”.

c. Once the project loads, the forward dosimetry user interface will launch in the system's default browser with all the datasets and simulations populated in the user interface. We recommend using Google Chrome as the default browser.

6.1.2 Running a forward dosimetry simulation and looking at the results.

a. Click on “Model Setup” on the top navigation bar. Navigate to the “Simulations” tab on the model setup page.

b. Select “Simple Forward Dosimetry Simulation” from the dropdown menu and click on Run Simulation.

c. Under the Model Outputs tab, select the concentration plots pane. Plot Arterial Plasma Concentration in the “Select Compartment” box. The resulting plot should look like this:
6.1.3 Running a Monte Carlo simulation and looking at results.

a. Navigate back to the “Simulations” tab under the “Model Setup” user interface.
b. Select “Forward Dosimetry with Monte Carlo simulation” from the dropdown menu and click on run simulations.
c. Under the Model Outputs tab, select the concentration plots pane. Plot Arterial Plasma and Fat total concentration. These would be box plots for Cmax of the Monte Carlo simulation.

6.1.4 Exiting the modeling user interface.

a. To exit the modeling interface at any point in time just click on the file button on the main navigation bar and click “Quit”.
b. This will open a dialog box asking if the user wants to exit this modeling session. Any changes made to the project since the last save will be lost. (Note: PLETHEM can only run one project at a time. To open a different project, the user must exit the existing modeling session as outlined here)
c. Click the confirm button to exit the session. The main window will turn grey.
6.2 Creating a project for a new model

Creating a new model project is the same for forward dosimetry, reverse dosimetry, and route-to-route extrapolation:

   a. Under the file menu, select “New” to create a PLETHEM project file to which the model can be saved.
   b. This opens the “Close current project and create a new one?” dialog so you can name the project.
   c. Name the project and click the “OK” button. PLETHEM will now ask you to select a location for the new project file. (note: this window may open behind you current Rstudio window).
   d. Select the directory in which you wish to store the project file and click “OK.

Once you have created a project, you can exit it anytime by clicking the file button on the main navigation bar and click “Quit”. This will create a dialog box asking if the user wants to exit this modeling session. Don’t forget to save any changes made before exiting the session.

If you quit the project as outlined above, please reload it by following the instructions in the “Load existing project” section before proceeding.

After the project has been established, we can start creating datasets for the model. PLETHEM uses a database to save all the parameter sets that users create for a project. The project file allows users to export the project to a RData file that can be shared with other PLETHEM users.

6.3 Creating datasets for the simulation

This guide aims to take users through creating datasets and simulations. PLETHEM has built in defaults for a large set of parameters needed to fully parameterize PBPK models. Users do not need to set all these parameters individually and PLETHEM uses the defaults values incorporated into our databases.

6.3.1 Creating an exposure dataset

   a. Open the model setup user interface by clicking on “Model Setup” on the navigation bar at the top.
   b. Navigate to the “Exposure” tab.
   c. Select the route of exposure desired form the sidebar to show the specific exposure inputs. The exposure options are: Oral, Drinking Water, Oral Exposure with Vehicle, Inhalation, Intravenous, and Dermal.
d. Enter a value for each box relative to dose of exposure and duration of exposure.
e. Click the “Save As” button.
f. Give the dataset a name and a description.
g. Click the “Add” button to save the set.
h. This creates an exposure set and the drop-down menu in the exposure tab is auto updated to show the set that was just created. (In order to add multiple exposure routes, click the “Reset Exposures” button before adding a new exposure.)

6.3.2 Creating a chemical dataset
a. Click on the “Chemical” tab in the user interface.

b. At this stage, you can enter manually the chemical parameters, or you can import them.
c. To import the chemical parameters, click the import button. This opens a window with tabs for the main database (“PLETHEM Database”), “Import from file”, and “User Database”.
   i. If you want to use one of the PLETHEM chemicals, click on the “Select Chemical” dropdown menu, click on the chemical of choice and then click “Import”.


ii. If you want to use on the chemicals from an existing user database, click on the “Select User Database”. This will open a window where PLETHEM now will ask you to select the file you want to import (note: this window may open behind you current Rstudio window). Once the Database is selected, click on the dropdown menu “Select Chemical” to choose your chemical and click on “Import”. (Note that User Databases are in SQLite format.)

iii. You can also import chemical information from a file. Click on “Browse”. This will open a window where PLETHEM now will ask you to select the file you want to import. Find your file and select the type of file you are importing (“Chemical Input File” or “OPERA Predictions”).
d. After selecting a QSAR model, click on the “Estimate Fraction Dissolved” button to estimate fraction of the chemical dissolved in the liquid phase of plasma.

e. Click the “Save As” button. A window will show what parameters have changed.

f. Give the parameter dataset a name and a description.

g. Click the “Add” button to save the set.

6.3.3 Creating physiological dataset

a. Navigate to the “Physiological” tab in the user interface.

b. Select the species and the gender under the “Organism” and the “Gender” drop-down menus, respectively.

c. Set the age under the “Age” drop-down menu.

d. Click the “Calculate Physiological Parameters” button to parameterize the model using life-course equations in PLETHEM.

e. Click the “Save As” button to save the parameter set. Name the dataset and give a description. Click “add” to save the physiological parameters. If the dataset does not appear in the dropdown menu right away, please refresh the page in the browser and check again.

6.3.4 Creating an ADME set

In PLETHEM, the ADME set is used to specify parameters related to absorption, distribution, metabolism, and excretion. They need to be defined for a specific combination of chemical, metabolite, exposure, and physiology.

a. Navigate to the “ADME” tab in the user interface.

b. If you have multiple exposure scenarios or multiple chemicals, select the right exposure and chemical set. If you want to track metabolites, select them in the drop-down menu or select no metabolites.
c. Select the “Absorption” tab. You can keep the default value or enter your own value. This tab may be empty depending on the route of absorption that was chosen (e.g. Dermal, IV).

d. Select the “Distribution” tab.

e. Select “QSAR Model One” to be used for estimating partitioning. The “QSAR Model One” refers to the default QSAR model in PLETHEM, which is adapted from the algorithm published by DeJongh et al. 1997.

f. Click the “Calculate Partition” button to estimate partition coefficients for all tissues that are part of the model. You can also enter your own values.

g. Each compartment can be described as blood flow limited or diffusion limited. PLETHEM assumes that the model is blood flow limited, which means that the permeability is set with a high value (1000). To switch the compartments to be diffusion limited, enter the appropriate permeability value.

h. Select the “Metabolism” tab in the ADME user interface. You can enter your clearance values in vivo or perform IVIVE if you have in vitro intrinsic clearance. We use the IVIVE algorithm within PLETHEM to scale in vitro intrinsic clearance to intrinsic clearance in vivo.
i. Click the “Perform IVIVE” button to open the IVIVE interface.

j. Select the organism.

k. IVIVE can be run for whole hepatocytes, sub-cellular fractions, or S9 Fraction. Select the model of interest. For each model, select the metabolism type by clicking on “Saturable” or “Linear” in the drop-down menu.
   i. If you select the “Whole Hepatocytes” tab, enter your Vmax or intrinsic clearance under “Hepatocyte Clearance” and select the units in the drop-down menu.
   ii. If you select the “Sub-cellular” tab, enter your Vmax or intrinsic clearance in “Microsomal Clearance” and/or “Cytosolic Clearance” and select the units in the drop-down menu.
   iii. If you select the “S9 Fraction” tab, enter a value for the “S9 Fraction Clearance” and select the units in the drop-down menu.
iv. **Note:** If you have a Vmax and a Km (Michaelis-Menten Constant), you can enter these values in the interface. If you have an intrinsic clearance, put a value of 1 for the Km and enter the Vmax under “Hepatocyte Clearance” as the intrinsic clearance is defined as the ratio Vmax under Km.

l. Click the “Perform IVIVE” button to extrapolate intrinsic clearance in vitro to intrinsic clearance in vivo.

m. Click “Save As” to save the ADME scenario and name it. Click “Add” to save it. The entire ADME set is then saved along with the chemicals, physiology, and exposure set it represents. This will be used later to filter the appropriate ADME set for selection when creating a simulation from these building blocks. Note: The “Save/Restore” button is unavailable in this version of PLETHEM.

n. You should now be able to see the exposure in the drop-down menu.

o. It is also possible to Upload age-based metabolism data by clicking on the “Upload Age-Based Metabolism Data” tab. A new window will open.

```
Upload Metabolism Data
```

i. Download the template file by clicking on “Template for metabolism file”.

ii. Enter your data and save this file on your computer.

iii. Click “Browse” and select the file you just saved on your computer.

iv. Enter a name and a description and select the metabolism type.

v. Click “Add Metabolism”. The new set of age metabolism data is now saved in the drop-down menu.

vi. To apply the data set, click on “Apply Data”. A window will appear to ask you to confirm as this will overwrite any existing data. Click “Ok”.

22
6.3.5 Creating a parameter variability dataset

a. Navigate to the “Uncertainty and Variability” tab in the user interface.
b. Select what kind of parameters you want to add variability to from the sidebar: “Chemical”, “Exposure”, “Physiological”, and/or “ADME”.
c. Click on the “New” button. This opens a window where we can create a new variability set.
d. Name the set and give it a description.
e. From the dropdown menu select the parameters for which you will be defining variability.
f. Click on the “Update List” button to populate the table below.
g. Define a CV and a distribution type. You can also set an Upper Limit or a Lower limit to avoid extreme values.

h. Click done to create the dataset.

6.4 Combining all the sets to make a simulation

6.4.1 Simulation Set- Creating a simple forward dosimetry simulation

a. Navigate to the “Simulations” tab in the user interface.
b. Click “New” to launch the “Simulation” dialog.
c. Give a name to the simulation and a description.
d. Select “Forward Dosimetry” in the “Simulation Type” tab.

e. Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and “ADME” tabs are selected.

![Simulation Type Tab]

f. Under the “Simulation” tab, set the “Simulation Start Time” and the “Simulation Duration” as well as the “Duration Units”.

![Simulation Tab]

g. Click the “Create Simulation” button to save the simulation. The simulation Description should be updated with all the simulation information.

6.4.2 Simulation Set – Creating a simulation for performing forward dosimetry with Monte Carlo analysis

a. Navigate to the “Simulations” tab in the user interface.
b. Click “New” to launch the “Simulation” dialog.
c. Give a name to the simulation and a description.
d. Select “Forward dosimetry with Monte Carlo” in the “Simulation Type” tab.
e. Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and “ADME” tabs are selected.
f. Under the “Variability” tab, make sure that the variability you set up is selected under the appropriate menu (“Physiology”, “Exposure”, “Parent Chemical” and/or “ADME”).
g. Under the “Simulation” tab, set the “Simulation Start Time”, the “Simulation Duration”, and the “Duration Units”. Select the “Number of Monte Carlo Runs” you want to run.

h. Click the “Create Simulation” button to save the simulation

6.4.3 Simulation Set – Creating a simulation for performing reverse dosimetry

6.4.3.1 Upload biomonitoring data

a. Navigate the “Biomonitoring Data” tab in the user interface
b. Click the “New” button to launch the import Biomonitoring Data Dialog.
c. Click “Browse” to find and upload the file containing the biomonitoring data. This file needs to be in a “CSV” format. You will find a template called “Biomonitoring Data.csv” at https://www.scitovation.com/plethem/. Once the data is uploaded “Upload complete” will appear below the file name.

d. Give a name and a description.

e. Biomonitoring data are usually measured in blood or urine. Select the “Tissue Type” and the appropriate data units in the drop-down menu.

f. Select the Chemical Type to define if the data is based on the parent compound or one of its metabolites.

g. Click “Save Set” to save the biomonitoring data. You will be able to see this kind of graphical representation of the biomonitoring data:

h.  

6.4.3.2 Create a simulation

a. Navigate to the “Simulations” tab in the user interface.

b. Click “New” to launch the “Simulation” dialog.

c. Name the simulation and add a description.

d. Select “Reverse Dosimetry” under the “Simulation Type” in the drop-down menu.
e. Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and “ADME” sets are selected. If a project contains multiple sets, you can select the appropriate one for the simulation you wish to perform using the drop-down menus.

f. Under the “Variability” tab, make sure that you have selected the parameters that will vary in this simulation.

g. The “Workflow Specific Inputs” tab allows users to define inputs and select datasets specific to the given simulation type. For reverse dosimetry, we need to define the biomonitoring dataset to use, an estimate for the range of exposures, and the number of exposures to run within that range for the DBA algorithm. The selected dose ranges and number of doses are driven by a general understanding of the model and scale of biomonitoring results. The DBA is an iterative algorithm for performing reverse dosimetry. It is very likely that in the initial range selected, either the range is too big, or the extremes are too high or too low to estimate an exposure. The Cumulative Distribution Function (CDF) plot and the Probability Distribution Function (PDF) graphs from the outputs are useful for refining this initial dose range. If the CDF has a long tail on one end and does not plateau on the other end, that indicates that the expected exposure is outside the range currently selected. If the CDF has a long tail at the lower exposure, that means the expected exposure is higher than the current dose range. The reverse is true if the tail is at the higher exposures.

h. Select the number of doses within the range for which to perform Monte Carlo calculation. Ideally this number is between 20 and 40.

i. Under the “Simulation” tab, set the “Simulation Start Time”, the “Simulation Duration”, and the duration units from the “Duration Units” drop-down menu. Select the “Number of Monte Carlo Runs” you want to run.

j. Click the “Create Simulation” button to save the simulation.

6.4.4 Simulation Set – Creating a simulation for performing route-to-route extrapolation

Before creating a simulation set for performing route-to-route extrapolation, there are a few more steps to follow.
6.4.4.1 Create the extrapolation exposure set

a. Navigate to the “Model Setup” tab.
b. Navigate to the “Exposure” tab in the user interface.
c. Click the “Reset Exposures” button to set all exposure values on the user interface to 0. PLETHEM can simulate only one active route of exposure at a time. If the exposure values for multiple routes are set, PLETHEM will show an alert and will not allow users to save exposure sets until the error is resolved.
d. Select the route of exposure for the extrapolation from the sidebar.
e. Set the dose of exposure to 1 (This is the route of exposure we want to extrapolate the dose for. We assign a dummy exposure value of 1 as PLETHEM requires exposure sets to have an exposure value) and all parameter related like the duration of exposure.
f. Click the “Save As” button to save the exposure set, naming it.
g. Click “Add” to save the exposure. Now you should have two exposure sets saved in the drop-down menu.

6.4.4.2 Create a simulation set

a. Navigate to the “Simulation” tab in the user interface.
b. Click “New” to launch the new “Simulation” dialog.
c. Give the simulation a name and a description.
d. Select “Route to Route Extrapolation” as the “Simulation Type.”
e. Under the “Parameters” tab, make sure the appropriate “Exposure”, “Parent Chemical”, “Physiology”, and “ADME” with the original Exposure scenario are selected. If our project contained multiple sets, we could select the set of our choosing from the drop-down menu.
f. Under the “Variability” tab, make sure that the “Physiological”, “Chemical” or “ADME” parameters you want to vary are selected. Since we will be estimating exposure, we cannot include exposure related variability in this workflow.
g. The “Workflow Specific Inputs” tab allows users to define inputs and select data sets specific for the given simulation type. For route to route extrapolation, we need to select the extrapolation exposure route, and estimate for the range of exposures and the number of exposures to run within that range for the Discretized Bayesian Approach (DBA) algorithm. The dose ranges and number of doses selected are driven by a general understanding of the model and scale of biomonitoring results. The DBA is an iterative algorithm for reverse dosimetry. It is very likely that in the initial range selected, either the range is too wide, or the extremes are too high or too low to estimate an exposure. The Cumulative Distribution Function (CDF) plot and the Probability Distribution Function (PDF) graphs from the outputs are useful in refining this initial dosage range. If the CDF has a long tail on one end and does not plateau on the other end, that indicates the expected exposure is outside the range currently selected. If the CDF has a long tail at the lower exposure, that means the expected exposure is higher than the current dose range; the reverse is true if the tail is at the higher exposures.

h. Set the “Exposure range” and select the number of doses to simulate within this range. Usually this number should be at least 20.

i. Under the “Simulation” tab, set the “Simulation Start Time” to 0, the “Simulation Duration” and the duration units from the “Duration Units” drop-down menu.

j. Click the “Create Simulation” button to save the simulation.

6.5 Running simulations and plotting results with the rapidPBPK model

6.5.1 Run a simple Forward Dosimetry Simulation

a. Select “Simple Forward Dosimetry” model from the simulation dropdown, then click “Run Simulation.”

b. Once the simulation completes running, the user interface switches to the model output tab. The “Model Output” tab allows users to view and export simulation results such as tissue concentrations and amounts. It also contains interfaces for importing datasets to plot against simulation results for viewing the results from Non-compartmental Analysis.

6.5.2 Concentration Plots – Plotting concentration plots

a. Click on concentration plots to open the concentration plot pane.

b. Select different compartments from the model tab.
c. By default, the data is plotted in µM. Select the mg/L radio button and ensure that the model scale and graph window changes to reflect the change in units.

d. Click on the table tab. This should show the concentration data for the compartments selected as returned by the simulation.

e. Click the “Get Data” button. This opens a window that asks the user for a name and location to save the model results as a csv file.

6.5.3 Adding external PK data to project

a. External concentration data in mg/L can be added to the project and plotted against concentration simulation.

b. Click the “Add dataset” button at the top of the model output page to open the “Add dataset” dialog box.
c. Enter a name and a description for the dataset.
d. Click the “Browse” button and navigate to the location on your machine where all the testing data is stored. Select the file to import. An example of formatted file to import in vivo data is provided: plethem_in_vivo_time_course.csv.
e. This should create a table displaying the data that will be imported.
f. Click the “Add dataset” button to add the data to the project.

6.5.4 Plotting PK data against simulation results
a. Make sure that the “Plot” tab is selected in the “Concentration Plot” panel.
b. Select the “Dataset” tab (next to the “Model” tab from where you selected compartments in the previous step).
c. Select the “Dataset” you imported from the “Select Datasets” dropdown.
d. This plots the data on the graph beside it. Make sure the units are selected to be “mg/L.”

6.5.5 Plotting exposure
a. Exposure plots can be seen under the “Exposure Plots” pane.
b. Plot both instantaneous exposure values as well as total exposure across the simulation duration for the active route of exposure or for all exposures (oral, drinking water, inhalation and intravenous).
c. The data behind the plots can be seen in the “Table” tab.

6.5.6 Plotting amounts
a. Amounts can be plotted from the “Amount Plots” panel.
b. Currently we cannot plot amount data from external sources.
c. These plots compartment values of amounts of chemical in different compartments in the model.

6.5.7 Mass Balance
The mass balance plot is an insurance that the model is well balanced. The curve should stay around 0.
6.5.8 Parameters

a. Click the parameters tab at the top to switch over to the view the parameters table.
b. You can see three tables, one for exposure, physiological and chemical parameters.

6.5.9 Running Monte Carlo analysis

a. Navigate back to the “Simulations” Tab on the “Model Setup” page.
b. Select the forward Simulation that was created with Monte Carlo.
c. Click the “Run simulation” button. Running Monte Carlo simulations take more time. Once the simulation is complete, the user interface will switch to the Model Output tab.
d. The concentration and amount plots change to box plots for Cmax values for each dose.
6.5.10 Running reverse dosimetry analysis

a. Navigate back to the “Simulations” Tab on the “Model Setup” page.
b. Select the Reverse dosimetry Simulation that was created.
c. Click the “Run simulation” button. By running reverse dosimetry, the model run multiple dose with Monte Carlo simulations which takes more time. Once the simulation is complete, the user interface will switch to the Model Output tab.
d. After the simulation is complete, PLETHEM runs the reverse dosimetry algorithm at the back end and creates a Cumulative Distribution Function (CDF) plot and a Probability Distribution Function (PDF) plot for the expected exposure. If the dose ranges are adequate, the graphs resemble CDFs and PDFs for log-normal distributions as in the figure below. You may not get the same results as shown below due to us running Monte Carlo Simulations.

e. The percentile values for the expected exposure are displayed under the “Exposure Estimates” tab. In the case study displayed here, using the model we parameterized, we expect the median exposure for the population to be approximately 0.0069ppm.
6.5.11 Running route-to-route extrapolation

a. Navigate back to the “Simulations” Tab on the “Model Setup” page.
b. Select the route-to-route extrapolation Simulation that was created.
c. Click the “Run simulation” button. PLETHEM will first simulate the model with the original exposure set (oral exposure for example) to generate a reference plasma concentration. Then PLETHEM will run the Monte Carlo simulations needed to run the DBA algorithm for estimating exposure through the exposure desired (Inhalation exposure for example). This process can take a long time. The progress bar will update users on the number of exposures the model has run. After the calculations are complete, PLETHEM will navigate to the Model output tab to display the results.
d. After the simulation is complete, PLETHEM runs the reverse dosimetry algorithm at the back end and creates a Cumulative Distribution Function (CDF) plot and a Probability Distribution Function (PDF) plot for the expected exposure. If the dose ranges are adequate, the graphs resemble CDFs and PDFs for log-normal distributions.
e. The percentile values for the expected exposure are displayed under the “Exposure Estimates” tab.

6.6 Importing exposure estimates into PLETHEM

6.6.1 Importing SHEDS-HT
SHEDS-HT is an R package for estimating exposures created by US-EPA National Exposure Research Lab (NERL). It makes use of the Consolidated Human Activity database and Consumer Product database to estimate exposure to chemicals in the population. The results are saved by SHEHDS-HT in an output folder as a csv file for each chemical that was run for a specific scenario. The output folder structure for

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONSUMERCASESTUDYCOHORTS</td>
<td>1/15/2019 9:58 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>ddd0</td>
<td>1/15/2019 9:58 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>derma0</td>
<td>1/15/2019 9:58 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>DIETTEST</td>
<td>1/15/2019 9:58 AM</td>
<td>File folder</td>
<td></td>
</tr>
</tbody>
</table>

SHEDS-HT is represented in the figure above. The folder containing these scenarios should be selected as the data folder in the user interface.

a. Navigate to the exposure tab in an open rapidPBPK project.
b. Select “Import Data”.
c. Select the “SHEDS Data” Tab.
d. Click the “Select SHEDS Data Folder” tab. This will open an explorer window.
e. Navigate to the folder where the SHEDS-HT results are stored and select it (Make sure you select the folder one level above the “output” folder).
f. This will populate the “Select Scenario” dropdown with the scenarios that were run in SHEDS-HT.
g. Select the chemicals you want to import data for, from the Select chemical dropdown.
h. Select either Population, Male or Female cohorts for which to import exposure data.
Click the Import selected exposures button to import the exposure estimates generated by SHEDS-HT. The exposure estimates will become available as exposure sets within the rapidPBPK project.

### 6.6.2 Importing TRA exposure estimates

ECETOC’s Targeted Risk Assessment (TRA) tool calculates the risk of exposure from chemicals to workers, consumers, and the environment. It has been identified by the European Commission’s Regulation on Registration, Evaluation, Authorisation and Restriction of Chemicals (REACH) as a preferred approach for evaluating consumer and worker health risks (ECHA, 2010 a,b).

- a. Navigate to the exposure tab in an open rapidPBPK project.
- b. Select “Import Data”.
- c. Select “TRA” tab.
- d. Click the “Browse” button under the “Upload Exposure Excel File” caption.
- e. Navigate to the location where the ECETOC TRA exposure excel file is saved on your PC and select it.
- f. This uploads the file to the rapidPBPK project and populates the “Select Exposure to export” dropdown with the scenarios that have been run in the TRA excel sheet.

- g. Select the scenarios that you want to import into the project.
- h. Enter the molecular weight of the compound. This is needed since inhalation exposures are estimated in mg/L by TRA but are needed in ppm by PLETHEM models.
- i. Enter the number of inhalation doses per week (between 1 and 7).
- j. Click the checkbox if the oral estimated should be repeated daily.
- k. Click the “Import Selected exposures” button to import the exposures into the PLETHEM Project.
6.6.3 Importing SEEM estimates into PLETHEM

EPA National Center for Computational toxicology developed the ExpoCast SEEM model that predict exposure estimates for a large set of compounds across different cohorts. SEEM estimates cannot be generated for chemicals by individual users. Instead they are generated in bulk by EPA and estimates are made available as publicly accessible databases. The following steps show how to import exposure estimates from SEEM into PLETHEM:

a. Navigate to the exposure tab in an open rapidPBPK project.

b. Select “Import Data”.

c. Select the “SEEM data” tab.

d. Click the “Select SEEM Data File” button. This opens an explorer window.

e. Navigate the “SEEM.sqlite” file that was downloaded from the link at the start of this document and click OK. This populates a set of radio buttons with categories as defined in the SEEM database.

f. Select category of chemicals for which you want to import the exposure estimates and click the “Get Selected Chemical List” button. This populates the dropdown menu underneath the “Select Chemicals to import” label.
From this menu select the chemicals you want to import into the project.

Select the type of exposures estimate you want to import for each of this chemical (Median and/or 95th percentile).

Click the “Import Selected Exposures” button to add these estimates to the PBPK project.

### 6.6.4 Importing ConsExpo exposure estimates into PLETHEM

ConsExpo is developed by RIVM, the Dutch National Institute for Public Health and the Environment and is a web application that can generate exposure estimates. ConsExpo results are exported as a csv file. This csv file can be read by PLETHEM.

- Navigate to the exposure tab in an open rapidPBPK project.
- Select “Import Data”.
- Select the “ConsExpo” tab.
- Click the “Browse” button to under the “Upload ConsExpo File” caption.
- Navigate to the location where you have saved the results file from ConsExpo and click “OK”.
- This will populate the “Select Exposures to import” dropdown in the User interface.

- Select the scenarios that you wish to import into the project. Both inhalation and oral exposure estimates for each of the selected scenario will be imported into PLETHEM.
- Finally click the “Import Selected Exposures” button to add these estimates to the PBPK project.

### 6.6.5 Importing Exposures using the batch import file

Some exposure estimation tools export data in non-standard formats or formats that make it difficult to incorporate support for them directly within PLETHEM. Additionally, the user may want to define their own set of exposures for the model that are not generated by an exposure estimation tool. To account for all such uses we have implemented the ability to import multiple exposures into the project using the batch
exposure import excel file. To import the data using the batch file, you will first need to download and populate the template “Exposures.xlsx”. Once you have done that the next steps are:

a. Navigate to the exposure tab in an open rapidPBPK project.
b. Select “Import Data”.
c. Select the “Batch Exposure” tab.
d. Click the “Browse” button under the “Select Exposure File” caption.
e. Navigate to the location where you have stored the “Exposures.xlsx” file, select the file and click OK. This will upload the file to PLETHEM.
f. Now click on one of the exposure tabs underneath the browse button to open that tab.
g. Select all the exposures you wish to import into the project from each of these tables.
h. Finally, click the “Import Selected Exposures” button to add these estimates to the PBPK project.
7 Performing high-throughput IVIVE using PLETHEM

7.1 Starting HT-IVIVE user interface and loading chemicals

7.1.1 Launching the HT-IVIVE user interface
a. Load the PLETHEM package using “library (plethem)”
b. Start a new HT-IVIVE project by typing interactiveHT() on the R console
c. This launches the HT-IVIVE user interface in the default browser

7.1.2 Importing chemicals to the project
a. Click on the “Import chemical” button at the top of the Setup page. This opens the import chemical dialog. This opens window with a tab for the user database and the main database (Some configurations cause a “invalid user database selected” message to appear. This can be safely ignored).
b. If you are using the Main Database, select the chemical from the drop-down menu.
c. If you are using your own database, select “User Database” (User Databases are in Sqlite format).
d. Click the “Select User Database” button, navigate to the file you want to import and select it.
e. Select the chemical from the “Select Chemical” drop-down menu.

f. Note that the window to select the database may appear behind your browser window. Just minimize the Rstudio and Browser windows and you should be able to see it.
g. Click the “Import” button to import the chemical into the interface.
h. Chemical information can also be imported from a .csv file.

7.2 Parameterizing the HT-IVIVE model

7.2.1 Entering Physiological and Chemical Parameters
a. To create a new model, click the “Add New Row” button in the user interface. This launches a new dialog box for parameterizing the HT-IVIVE model. The dialog box has tabs for the different inputs needed for the HT-IVIVE model. Most values are auto filled based on the parameter sets within PLETHEM and the selected chemical. If you did not import a database or information on a specific chemical, you can select “Generic Chemical” from the “Select Chemical” tab and populate the chemical information yourself.

b. Hovering over some input boxes results in the appearance of a popup text box suggesting valid inputs. These suggestions have not been calibrated for all inputs and can be ignored at this time. This will be addressed in upcoming versions of the tool.

c. Navigate to the “Physiological and Chemical Parameters” tab in the dialog window.
d. Enter the exposure estimate for this chemical in the “Environmental Exposure (mg/kg/day)” box.
e. Finally give this estimate a name.
7.2.2 Enter the in vitro point of departure
Next, we enter the in vitro point of departure for the chemical selected.

Navigate to the “Invitro POD” tab in the dialog window and enter a value in the “Invitro POD” box. Make sure the appropriate unit is selected from the “Unit” drop-down menu.

7.2.3 Select the HT-IVIVE Type
Navigate to the “HT-IVIVE Type” tab in dialog window and select the kind of IVIVE that needs to be run.

7.2.4 Parameterizing Clearance Models
For metabolism, the model includes options for clearance in the liver, urine, and blood.

a. Navigate to the “Hepatic Clearance” tab. You have the choice between “Subcellular Clearance”, “S9 Fraction Clearance”, “Whole Hepatocyte Clearance” and “Enzymatic clearance. The clearance scaling can be done with the classic “Rowland Equation” or by assuming “Restrictive Clearance” or “Non-Restrictive Clearance”.

i. If you select “Subcellular Fraction”, enter a value under “Measured Microsomal Clearances” and/or “Measured Cytosolic Clearance”. Make sure the appropriate units are selected from the “units” drop-down menu.

ii. If you select “S9 Fraction”, enter a value under ‘Measured S9 Fraction Clearance”. Make sure the appropriate units are selected from the “units” drop-down menu.

iii. If you select “Whole Hepatocyte Clearance”, enter a value under ‘Measured Whole Hepatocyte Clearance”. Make sure the appropriate units are selected from the “units” drop-down menu.

iv. Note: If you have a Vmax and a Km (Michaelis-Menten Constant), you can enter these values in the interface. If you have an intrinsic clearance, just put a value of 1 for the Km and enter
the Vmax under “Clearance” as the intrinsic clearance is defined as the ratio Vmax under Km.

v. If you select “Enzymatic Clearance”:
   1. Download the “Template for CYP Clearance Data”. A .csv file will open.
   2. Enter the in vitro clearance values for each enzyme metabolizing the chemical of interest. Units needs to be in µL/min/pmol protein.
   3. Click on the “Upload CYP clearance” and select the csv file you saved on your computer with your enzyme’s clearances. This will populate the table with your enzymes of interest.
b. Navigate to the “Renal Clearance” tab in the dialog window and check the “Include Renal Clearance box” if necessary.

![Renal Clearance Tab]

b. Navigate to the “Renal Clearance” tab in the dialog window and check the “Include Renal Clearance box” if necessary.

Input HT-IVIVE data

<table>
<thead>
<tr>
<th>Physiological and Chemical Parameters</th>
<th>In vitro POD</th>
<th>HT-IVIVE Type</th>
<th>Hepatic Clearance</th>
<th>Renal Clearance</th>
<th>Clearance in Blood</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glomerular Filtration Rate (L/h)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Include Renal Clearance

Renal Clearance is calculated as a product of Glomerular Filtration Rate measured in L/h and Fraction of chemical unbound in Blood Plasma

![Renal Clearance Calculation]

c. If you also have clearance data in blood, in the “Clearance in Blood” section, enter a value in the “Measured Plasma Clearance” box.
d. Click “OK” to parameterize the model with the values you just entered. The parameterized model is added as a row in the table on the “Setup” tab of the interface.

7.3 Running the HT-IVIVE Model and saving results

7.3.1 Running the HT-IVIVE model

a. At this point you can continue to add more chemicals into the project or add more points of departure for chemicals already in the project. After creating a model for each chemical and POD combination for which you want to calculate an equivalent applied dose, click the “Perform HT-IVIVE” button to run the HT-IVIVE model. Once completed, PLETHEM switches to the results tab.
b. The results tab is a table that summarizes the input that went into the model along with certain calculated values from the model itself.
c. The calculated parameters include:
   - Actual Hepatic/Renal/Plasma Clearance—the in vivo clearance in L/h that is calculated by scaling in vitro values to in vivo values.
   - CSS—the steady-state plasma concentration in vivo that will result from the standard 1 mg/kg/day exposure.
   - Equivalent dose—the equivalent applied dose in vivo that would generate a CSS equal to the observed point of departure in vitro.
• Margin of Exposure—the ratio of the estimated in vivo exposure to the equivalent dose corresponding to the in vitro POD.

d. The table can be copied to the clipboard for pasting into another program (e.g., Excel) using the “Copy” button, or downloaded as a “csv” file using the CSV button on the screen.
8 Kinetically Derived Maximum Tolerated Dose Workflow

8.1 Template for the KMD workflow in PLETHEM

Data for the KMD workflow in PLETHEM is defined in the excel template “KMD Data Template.xlsx” that can be downloaded from the application itself. The figure below is a screenshot of the excel file with data from an example study filled in. The first two columns represent the nominal and actual exposure values for the experiment. The design of this inhalation study meant that the rats’ exposure as per the study design (nominal exposure) and the exposure to the rodents in the study (actual exposure) were the same. The last of column of the spreadsheet is the replicate number for each exposure. PLETHEM needs this column to group the measured study values by exposure. The rest of the columns are for measured study values. For this case study we used a small number of data points that were measured in the study. It is important to note that all the data was not collected in a single experiment. Also, there were some replicates where values were not measured (encoded “NA”).

8.2 Accessing the web application

a. Since this workflow is entirely independent of the PBPK model in PLETHEM, it is best suited as a standalone tool that is available for use without needing to install R, Rstudio, and the PLETHEM package.

b. Open a web browser (preferably Google Chrome).

c. Navigate to https://scitovation.shinyapps.io/plethem-MTD/

d. This will open the PLETHEM KMD web application.
8.3 KMD workflow in PLETHEM

8.3.1 Upload the filled template

a. Download the “Sample data file”. A .csv file called “kmd_sample_data.csv” will open.
b. Enter your own data. The last column called “reps” is the number of replicates. Save this file on your computer.
c. Click the “Browse…” button to open an upload file window.
d. Navigate to the location on your computer where you have stored the template file downloaded in step a.
e. Select the file to upload it to the web-app. You will get a notification “Upload complete” under the “Browse...” tab.
f. The file will be uploaded and PLETHEM will run the KMD workflow for the first series of measurements.
8.3.2 Interpreting the results

a. Select the appropriate axis type by selecting “Log” or Linear under the “y-axis” and/or “x-axis” drop-down menu.

b. From the left side menu choose the endpoint to display under the “Select Response Endpoint” drop-down menu. You will be able to see the values for each data point by navigating your mouse over the data point at each exposure.

c. The blue circles represent the expected value of the measured endpoint if the dose response for the parameter was linear in the given dose range. The red circles represent measured values that are significantly different (either higher or lower) than the expected value. This indicates points at which the response no longer follows a linear dose response relationship and hence any doses beyond this range cannot be used for assessing human risk.

d. The KMD table provides more detailed information on the statistics of nonlinearity. Choose the “table” tab above the graph to see the table. As this example indicates, the rats were exposed to increasing concentrations of a chemical up to 1600 ppm. None of the rats in the study showed any significant change in the body weight throughout the study. Using classical Maximum Tolerated Dose (MTD) analysis, a top dose of 1600 ppm would have been used to perform further response in a lifetime study. However, the toxicokinetic profile shows a non-linearity in the dose response at 1200 ppm. This indicates that the kinetics of this chemical are no longer valid for extrapolation to humans beyond a highest dose of 1200 ppm – the kinetically derived maximum tolerated dose. This dose then should be used as the top dose in future studies.
9 Using Forward Dosimetry in Ecotoxicology

9.1 Creating a new project

a. Load the PLETHEM package using “library(plethem).”
b. Launch the PBPK modeling workflow by typing interactivePBPK(“fishPBPK”) in the R console. This launches the forward dosimetry user interface in the default browser.

9.2 Create an exposure set

a. Navigate to the “Model Setup” tab.
b. Navigate to the “Exposure” tab in the user interface.
c. Set the “Concentration in Water”.
d. Click the “Save As” button to save the set and name it.
e. Click “Add” to save the exposure.

9.3 Create a chemical set

a. Navigate to the “Chemical” tab in the user interface.
b. Enter the appropriate input values.
c. Click “Save As” to save the parameter set.
d. Click “Add” to save chemical parameters.
e. Note: The user has the choice of using Vmax and Km or an intrinsic clearance. If the user enters an intrinsic clearance, the Michaelis-Menten Constant (Km) needs to be set to 1. PLETHEM is calculating the intrinsic clearance as Vmax under Km.

9.4 Create a physiological set

a. Navigate to the “Physiological” tab in the user interface.
b. Select the species under the “Organism” drop-downs menu.
c. Enter the partition coefficient for the chemical in each tissues compartment.
d. Click the “Save As” button to save the parameter set. Name the set and click “Add” to save the physiological parameters.

9.5 Define variability

a. Navigate to the “Uncertainty and Variability” tab in the user interface.
b. Select “Physiological”, “Chemical”, and/or “Exposure” from the sidebar to define what parameters will vary.
c. Click on the “New” button to open the variability interface. Name this set.
d. Select the parameters from the drop-down menu located under the “Select Parameters to Assign Variability” and click the “Update List” button. This will also lead to different tissue volumes and blood flows to be scaled appropriately.
e. Assign “Coefficient of Variation” and “Type of Distribution” to the parameters as shown in the figure below.
f. Click “Done” to save the variability set. At this point it is a good idea to save the entire project by clicking the “Save” button in the “File” menu.

9.6 Create a simulation

All the sets are put together to create a simulation.

a. Navigate to the “Simulations” tab in the user interface.
b. Click “Create new simulation” to launch the “Simulation” dialog.
c. Name the simulation and add a description.

d. Under the “Select Chemical”, “Select Exposure” and “Select Compartment” tabs, make sure the appropriate “Chemical”, “Exposure” and “species” are selected.

e. Under the “Variability” tab, make sure the right parameters are selected.

f. Set the “Simulation Start Time”, and the “Simulation Duration”. The default number of Monte Carlo runs is set to 1000.

g. Check the “Run Monte Carlo Simulation” tab if you want to run a Monte Carlo analysis.

h. Click the “Create Simulation” button to save the simulation. A window will pop-up saying “Simulation saved as ...” with the name you gave to that simulation. Click “Ok”. You can now see the information about your simulation on the screen.

9.7 Running the simulation

a. Select the simulation you wish to run from the drop-down menu.

b. Click the “Run” button. If the selected simulation is a Monte Carlo simulation, a progress bar will appear above the “Run Simulation” as the simulation proceeds in the bottom right corner.

c. After the simulation is complete, PLETHEM will switch over to the “Model Outputs” tab.

9.8 Viewing and exporting simulation results

The “Model Output” tab allows users to view and export simulation results such as tissue concentrations and amounts. It also contains interfaces for importing datasets to plot against simulation results for viewing the results from Non-compartmental Analysis.

a. Select the “Plots” tab on the “Model Outputs” page.

b. Select the “Concentration plots” panel and select tissues from the multiple selection menu on the left.

c. This creates a curve or for Monte Carlo analysis, a box plot for the tissue concentration in the plot window on the right.
d. Selecting the “Table” tab on the concentration panel brings up the actual concentrations for each curve or Cmax values behind the box plot. These values can be exported by clicking on the “Get Data” button below the table.